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PREFACE

“I love the flexibility of participating in the interactive exercises either on the NP4
Web site or on the Book-on-CD! | can decide what works best for me.”

Alexa Griffin, student tester

About New Perspectives on
Computer Concepts, 4th Edition

With the 4t edition of Computer Concepts, we're building on a legacy of excellence.
With each new edition we are able to offer you more. The 4t edition is no exception.
We've retained the great features of the previous editions that you've told us you liked
and added some new features we know you’re going to love. If you want a truly excel-
lent introduction to computers, look no further than Computer Concepts, 4th Edition.

Flexibility

Whether you use the book alone, or use it with the Book-on-CD and/or the dedicated
Web site, it’'s your choice. Let your needs dictate how you use this integrated text and
technology package. Our goal is to provide you with you with flexible, innovative teaching
and learning tools. With our solid pedagogy and proven technology, New Perspectives
on Computer Concepts is reaching new students everyday.

Classic Features

g As with the popular 3™ edition, the 4th edition features a CD-ROM that contains the
— entire contents of the book. Every page of this Book-on-CD looks exactly like the printed

~__ book, so you can use either one—or both. The Book-on-CD also contains animated
ol software tours, videos, Course Labs, InfoWeb links, and more. Students, instructors,
and beta testers have given high marks to the Book-on-CD because it adds an inter-
active dimension to the learning experience.

e

N Start For the 4! edition we’ve added more animated software tours that demonstrate pop-
14! Screentour ular software packages, such as Microsoft’'s Internet Explorer Web browser, Coda
Software’s Finale MIDI music toolkit, Caligari TrueSpace 3-D graphics, and more!

We've updated our highly interactive, computerized Course Labs. The labs combine
illustrations, animation, digital images, and simulations. They make computer skills and
concepts fun and easy to understand. The labs provide step-by-step tutorials, present
reinforcement questions, and allow independent exploration. For the 4th edition, we've
added an exciting new lab on Photo Editing. See page xi for a complete listing of the
Course Labs that accompany this book.

We've retained our interactive assessment options such as QuickCheck questions at
the end of every section. Practice Tests at the end of each chapter generate computer-
scored tests from a test bank of 150 questions per chapter. You will also find a rich
selection of end-of-chapter Projects, Lab Assignments, and InfoWeb links that
helped make the 3 edition such a success.

If you're looking for a solution for local or distance learning courses, CyberClass might
be for you. It is a Web-based tool designed for on-campus or distance learning. To learn
more, go to: www.cyber-class.com
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New Features in the 4th Edition

A Great New Web Site

Now you can do more on the Web! Explore InfoWeb links to research a topic of interest
or participate in a multitude of new interactive end-of-chapter activities that include
summary exercises, key terms, quizzes, study tips, and additional projects. Or, simply sit
back and watch a video. It’s all at your fingertips at the new, NP4 Web site,
www.cciw.com/np4.

Issue Feature

Students can read about current ethical, social, and cultural computing issues in the new
Issue section at the end of each chapter, then provide their opinions verbally or
electronically. Instructors can collect, summarize, and display a chart of student
responses using the Consolidation Module found on the IRK. It's a great way to spark
classroom discussion!

Interactive Key Terms, Pop-up Definitions & Glossary

Computer terms that can be difficult to remember won’t be a problem anymore. Students
can now interact with the Key Terms list at the end of each chapter to review new terms.
We've also added pop-up definitions that appear on screen when using the Book-on-CD
and a Glossary button provides easy access to all definitions from any page in the book.

If you want to take your course online, you can use WebCT to help you. WebCT is a
flexible course management tool that allows instructors to host a course Web site on a
campus server. Course Technology offers FREE content-specific information for
Concepts, 4! Edition. To learn more, go to: webct.course.com

Supplements

The following supplements accompany New Perspectives on Computer Concepts,
4th Edition.

Course Labs: Bring Concepts to Life Computer skills and concepts come to life with
the New Perspectives Course Labs—27 highly interactive tutorials that present step-
by-step instruction, allow independent exploration, and provide printed feedback.

. CG.F4*’

o =, Course Online: A Site Dedicated to Keeping You Up To Date We offer a dedicated
Web site for students and instructors who use New Perspectives on Computer Concepts.

Instructors may visit the site’s password-protected Faculty Online Companion for solu-
tions, frequently asked questions with answers, articles, content updates, and more.

&
-
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Course Presenter: Ready-Made or Customizable Presentations Course Presenter
is a CD-ROM-based presentation tool that provides instructors with a wealth of
resources for use in the classroom, replacing traditional overhead transparencies with
computer-generated presentations. Presenter includes a structured presentation along
with videos, animations, Course Labs, and more for each chapter of the textbook. It
also provides flexibility to create customized presentations.

Course Test Manager: Testing and Practice Online or On Paper Course Test
Manager is a powerful testing and assessment package that enables instructors to cre-
ate and print tests from testbanks designed specifically for Course Technology titles. In
addition, instructors with access to a networked computer lab can administer, grade,
and track tests online. Students can also take online practice tests, which generate
customized study guides that help students locate review information in the book.

Electronic Instructor’s Manual: Help is Only a Few Keystrokes Away This
enhanced Instructor’s Manual offers an outline for each chapter; suggestions for
instruction on the chapter content, including how to effectively use and integrate the
InfoWebs, the CD content, and the labs; answers to the end-of chapter materials
(Review, Projects, and Lab Assignments); and numerous teaching tips.

Consolidation Module: Find Out What Your Students Are Thinking The
Consolidation Module allows instructors to gather student data from interactive activities
(including the Issue sections), consolidate student scores, and print assessment reports.
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DOS Directories and File
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Before You Begin

BEFORE YOU BEGIN

You’re going to enjoy using New Perspectives on Computer Concepts 4th Edition and
the accompanying Book-on-CD. It’s a snap to start the Book-on-CD and use it on your
computer. So don’t delay—qget started right away! The answers to the FAQs (frequently
asked questions) in this section will help you begin.

FAQ

: e 2
Will the Book-on-CD work on my computer” The Book-On-CD works on most

computers that run Windows. The easiest way to find out if the Book-on-CD works on
your computer is to try it! Just follow the steps below to start the CD. If it works, you're
all set. Otherwise, check with your local technical support person. If you are technically
Inclined, the system requirements are listed inside the front cover of this book.

-on-CD?
How do | start the Book-on-CDr The New Perspectives on Computer Concepts

4th Edition Book-on-CD is easy to use and requires no installation. Follow these simple
steps to get started:

1. Make sure your computer is turned on.

2. Press the button on your computer’s CD-ROM drive to open the drawer-like “tray” as
shown in the photo below.

3. Place the Book-on-CD into the tray with the label facing up.

4. Press the button on the CD-ROM drive to close the tray, then proceed with Step 5
on the next page.

FIGURE 1

To use the Book-on-CD, your
computer must have a CD-ROM
drive. If you have any questions
about its operation, check with
your local technical support
person.

Open/close tray button
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5. Wait about 15 seconds. During this time, the light on your CD-ROM drive should
flicker. Soon you should see the Computer Concepts Welcome screen.

~ New Perspechives on Computer Concepts

FIGURE 2

The Welcome screen displays
the menu of options for the T gl gl

Book-on-CD. Typically, you'll Use the Welcome
click the Contents menu, then screen’s menu bar
select the chapter that you want

to access the pages 2 iy
to read. and activities s C.l O f f .I (.) LJ .!:
provided on the

NEW PERSPECTIVES SERIES Book-on-CD

g NOA 910)9g

Use the Media menu to jump to e -

pages containing a video, - DOOK:OR-LHl r O f .] LS L
animation, or software tour. Thomson Learning.. J
Use the Labs menu to jump to

any Lab.

Use the Tests menu to jump to V\-’elcorne!

a computer-scored Practice Test .

for any chapter. Welcome!

_ Welcome!
Use the Tools menu to view

your Tracking Disk data, turn
sound on or off, and change the
default browser.

uiba

Use the File menu to exit.

FIGURE 3
Manual Start: Follow the
instructions in this figure
only if the Welcome screen
did not appear automatically
in Step 5.
Tmhmdamﬁlu chunlt,am
Se 2. When the mm W—"‘———j
Start menu - — =
Clle Flun g aeme—
3. Ty e d \start then ) ik
the OK button.
If your CD-ROM drive is not
“d” you should substitute the
. _ | letter of your drive—for
1. Use the mouse to T e B example, q:\start.
|position the arrow-shaped St - |
pointer on Start, then click

the left button on ynur
mouse, .

How do | end a session?

You’'ll need to leave the Book-on-CD disk in the CD-ROM
drive while you're using it. Before you remove the CD from the drive, exit the program
by clicking the Exit button at the top of the screen.
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FIGURE 4 bl

The Jump To button lets
you enter any page number.

The Page » button takes (Bl Navigation

The 4 Page button takes
you to the previous page.

You can use the mouse to libraries. Humans can do all these activities, but a computer can
drag the scroll box or click much more rapidly and more accurately. Our ability to use a c Scrﬂ" bar
the scroll bar to view the our mental capabilities and may make us more productive. The kM

rest of the page.

" Start
B4 Video

How do | navigate from page to page? ICIick the Contents menu to jump to any

chapter, section or page number of the book. To move from page to page, you can click
the navigation buttons at the top of the screen. To read down to the text at the bottom
of a page, drag the scroll box or click the scroll bar at the side of the screen.

Conte nts menu;_

vigat "cun buttans

Computers have been called "mind tools” because they enhance our ability to perform

tasks that require mental effort. Computers are adept at performing activities such as
making calculations quickly, sorting large lists, and searching thmugh vast mfnrmatlnn

use of the computer as a tool is to know what a computer does, hnw it works, and how
you can use it.

_ . — " 2 .
How do | view videos, animations, and screentours” Many of the figures con-

tain a Start Video, Start Animation, or Start Screentour button, such as the sample one
pictured to the left of this paragraph. When using the Book-on-CD, you can click these
buttons to see videos clips, watch animated conceptual diagrams, and tour through
popular software packages.

What's an InfoWeb? |1he |nfowebs provide up-to-date links to Web sites where

you will find additional information about important topics covered in each chapter.
When you’re using the Book-on-CD, you can click any InfoWeb icon that you see in the
margin of the book to be connected to a list of corresponding Web sites. This list is
updated regularly, so that you'll be getting the most current information.

The InfoWeb links work only if you have a browser and an Internet connection. If you
can send e-mail and access the Web with your computer, you probably have such a
connection. If this is the case, when you click an InfoWeb icon, your Book-on-CD will
automatically start your Web browser software and dial up your connection.

If you do not have an Internet connection, you will not be able to access the auxiliary
material provided by InfoWeb links. You might want to consider setting up an Internet
connection with a national Internet service provider (ISP), such as America Online, or
with a local ISP that you find in the Yellow Pages of your telephone book (look under
“Internet”). The InfoWebs are a helpful supplement to the NP4 textbook, but, an
Internet connection is not required to use the book or the Book-on-CD.

When you complete your exploration of InfoWeb links, you can return to the Book-on-
CD by closing your browser. Click your browser’s File menu, then click Close or Exit .



What 18 the NP4 Yeb slter The NP4 Web site contains the first two pages of

every chapter, including the chapter preview video, list of chapter topics, chapter objec-
tives, and opening feature story. In addition, the Web site contains the Issue section
and all of the end-of-chapter activities, including the interactive summary, key terms,
quizzes, study tips, practice tests, projects, lab assignments, and InfoWebs.

You can interact with the Web-based material just as you would with the Book-on-CD.
You can watch videos, complete interactive activities, view your scores, and save your
scores on a Tracking Disk. The NP4 Web site is a handy—and portable—companion
to the book.

&Cess ‘MS”E? ITo access the NP4 Web site, you need

Microsoft Internet Explorer (included with Windows). You will also need an Internet con-
nection provided by your school or by an Internet service provider (ISP).

Whenever you want to visit the NP4 Web site, start your browser software and connect
to the Internet. Enter the address www.cciw.com/np4.

The first time that you access the site, your browser will download a program that
allows you to view the NP4 pages, interact with the end-of-chapter activities, and
receive computer-scored results. The download takes approximately five minutes,
depending on the speed of your Internet connection. When the download is complete,
follow the instructions on the screen to make sure that your computer will display every-
thing correctly.

For those of you with some technical background, note that the download is digitally
signed to ensure that it is a legitimate program and that it does not carry a virus.

‘How do the interactive summaries, quizzes, and practice tests work? \When

you use the Book-on-CD or the NP4 Web site, you can use a variety of activities to
review the chapter material and make sure that you understand the important points.
Simply follow the instructions for these activities to enter your answers. When you've
completed an activity, the computer will automatically check your responses and pro-
vide you with a score. For Practice Tests, you will also receive a study guide to help
you find the answers to questions that you answered incorrectly. You can print this
study guide by following the instructions on the screen.

You have the option of saving your results on a Tracking Disk, as explained on the next
page.

' ?
whal aiout tne Interacm At the end of each chapter, a list of key

terms helps you review new terminology. Follow the directions at the top of the page to inter-
act with the key terms list. Your results are not scored or saved.

g NOA 910}99

uiba
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FAQ

hat's a Tracking Disk? |z Tracking Disk tracks your progress by saving your

responses to the “What do you think?” questions on the Issues pages as well as your
scores on the QuickChecks, Interactive Summary, Interactive Quizzes, and Practice
Tests.

When you complete an activity, such as a QuickCheck, you’ll see a message that asks
if you would like to save your score. If you click the OK button, you will be prompted to
insert your Tracking Disk, then your score will be saved on it.

The first time you save a score, you will need to follow the directions on the screen to
create a Tracking Disk. To do so, click the Create button and insert a blank, formatted
floppy disk. You only need to create a Tracking Disk one time. Once you've created
the Tracking Disk, just insert it into the floppy disk drive of your computer when you
insert the Book-on-CD or when prompted to do so.

You can view or print a summary report of all your scores by using the Tools menu on
the Welcome screen. In an academic setting, your instructor might request your
Tracking Disk data to monitor your progress. If this is the case, you might want to make
a copy of your Tracking Disk (refer to page 420 in the Introductory or Comprehensive
editions).

FAQ

What about sound? If your computer is equipped for sound, you should hear audio

during the videos. If you don’t, check the volume control on your computer by clicking
the speaker icon in the lower-right corner of your screen. If you're working any place
where sound would be disruptive, consider using earphones. You can also use the
Tools menu on the Welcome screen to turn sound off.

FAQ

Can | make the type appear larger on my screen? If the type in the Book-on-CD

appears small, your monitor is probably set at a high resolution. The type will appear
larger if you reduce the resolution by using the Start menu to access Settings and
Control Panel. Double-click the Display icon, then select the Settings tab. Move the
Screen Area slider to 640 x 480. This setting is optional. You can view the Book-on-CD
at most standard resolutions.

If your Book-on-CD text looks jumbled, your computer might be set to use Windows
large fonts, instead of the standard font. The standard fonts setting is located on the
Scheme list that you can access by double-clicking the Display icon in Control Panel,
then selecting the Appearance tab.

lWhat if | have additional questions about how to use the CD or Web site? l

Additional technical information about the NP4 Book-on-CD and NP4 Web site is pro-
vided in the Readme file on your CD. To read this information, use the Programs option
on the Start menu to view a list of programs on your computer. Select Windows Explorer
from the list. Click the icon that represents your CD-ROM drive. Locate the program
Readme or Readme.ixt in the list on the right side of the screen and double-click it.
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